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I am a PowerPivot FanBoy.
I remember the exact moment that this happened.
Once a year, Microsoft invites all of their MVPs to
Redmond, Washington, for the MVP Summit. The
event consists of two days of executive keynotes and
two useful days spent with the project managers of
your individual technology. I always go to the MVP
Summit, looking forward to spending time with the
Excel project managers. During those two days, you
go from meeting to meeting on the Redmond campus, hearing about various plans for the next version
of Excel.
On Wednesday of the 2009 Summit, the noon
meeting was not in the usual building 33 that
houses the Excel team. As I walked into that room
in another building, I noticed something strange.
The left side of the room was filled with people I
knew: the Excel MVPs. They are people whom you
know of if you read Excel books or if you’ve asked
a few questions at the MrExcel.com message board:
Curt Frye, Bob Umlas, Richard Schollar, Smitty,
Greg Truby. The right side of the room was full of
a bunch of people whom I had never seen before.
They were eyeing us suspiciously, and we were
wondering what the heck they were doing in our
meeting.
The speaker that day was Donald Farmer. Scottish.
Hair longer than JWalk’s. He comes walking in, carrying a desktop PC under his arm. Read that again.
He came walking in with a desktop PC. Who shows
up to a presentation carrying a desktop PC? Donald
set up the PC in the front of the room, plugged it
into the projector, and proceeded to start a demo
about something called Project Gemini.
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“There’s Row 20 Million”.................................2
“The PivotTable Field List Has Fields
from Both Tables”...........................................2
There Could Be Five Titles for This Book...........4
Who Are Those Other People in the Room? ......5
How This Book Is Organized ............................7
Conventions Used in This Book........................7
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Introduction

“There’s Row 20 Million”
Donald Farmer had carried in a 64-bit windows machine with 8GB of RAM. By Christmas
of 2009, you could walk into Best Buy and buy such a machine, but I had never seen a
machine with more than 3GB of RAM in early 2009.
Donald sets up a scenario. He had two data sets:
■ Data set 1 was every DVD rental transaction at a fictitious chain of video stores.
■ Data set 2 was box office data that he had downloaded from the Internet.
Donald fires up something that looks basically like Excel and shows us data set 1. He grabs
the vertical scrollbar on the right side of the data and starts to scroll. Like a hot knife
through butter, the PC responded snappily and Donald says, “There’s row 20 million.”
It literally did not sink in with me.
Donald continued...
“There’s row 40 million.”
“There’s row 60 million.”
“There’s row 100 million.”
I am thinking to myself that it is 2009 and seeing row 1 million in Excel was exciting at the
2006 Summit, but really why is this guy wasting our time showing us that Excel now has a
million rows?
Wait. Did. He. Just. Say. 100. Million? I looked at the screen and tried to focus on how
many digits were in the row count at the bottom of the screen.
Donald went on to sort 100 million rows. He used the AutoFilter drop-downs to filter
100 million rows.
Here is a guy who carried in a desktop PC and had a 100 million row data set in something
that looked like Excel. I decided I better close my Outlook and pay attention.

“The PivotTable Field List Has Fields from Both Tables”
Donald proceeds to build a pivot table from the 100 million rows of data. This seems only
natural. What else would you do with 100 million rows of data? Just about any time that
I get a data set, my first inclination is to build a pivot table, so making a pivot table makes
perfect sense.
There is something weird with the pivot table field list, however. It is listing fields from
both table 1 and table 2. Donald is only using data from table 1, though. He adds one of
the new slicer filters that we had just learned about the day before.

The PivotTable Field List Has Fields from Both Tables

3

Then, Donald suggested that we compare rentals by genre with box office receipts by
genre.
For all of the Excel people reading this book, a very easy quiz. To mash up the data from
Sheet1 with Sheet2 what tried and true method will you have to use?
a. =VLOOKUP() functions
b. =INDEX() functions
c. Cut and paste
d. =VABRACADABRA() function, preferably while waving a magic wand
Of course, the answer is a. A nice set of VLOOKUPs will get the data from one sheet onto
another sheet. Although, I cringed, 100 million VLOOKUPs are going to take a long time.
Except Donald didn’t knock out a VLOOKUP function.

NOTE

All he did was clicked a field from table 2 in the pivot table field list. This was an early version of the product and a ToolTip popped up saying “We’ve inferred a relationship between
table 1 and table 2”. The box office data was now summarized in the same pivot table as the
DVD rental information.

According to Rob Collie,“stuff that looks good in a demo may not actually work well when real people
try to use the product.” Microsoft ended up backing off from the automatic relationship detection in
favor of giving people some control over setting up a relationship. It is still very easy to do, easier than
setting up a VLOOKUP.

Now, I Love VLOOKUPs
To me, there are two kinds of people in the world.
■ People who can do a VLOOKUP with their eyes closed
■ Everyone else
If you’ve happened to catch one of my live Power Excel seminars, I usually talk about how
I used to be a manager of financial analysis. When we needed to hire financial analysts, the
person in Human Resources would ask about what requirements I wanted on the job posting notice. I usually had a single requirement: “Can do VLOOKUPs in their sleep.” As
long as someone could do VLOOKUPs, everything else would fall into place.
I don’t want to sound harsh, but it comes down to this; if you can do VLOOKUPs, you are
employable. If you can’t do VLOOKUPs, well, you might be employable, just not by me.
When Donald Farmer clicked a box next to field from Sheet 2 and Excel produced a pivot
table from two worksheets without having anyone enter a VLOOKUP function, that was a
game-changer.
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Suddenly, hundreds of millions of people who (a) know how to use a mouse and (b) don’t
know how to do a VLOOKUP are suddenly able to perform jaw-dropping business intelligence analyses. They all might actually be employable, by me.

“How Much Will This Cost? Well, the Client Is Free”
It was crazy talk.
Microsoft was demonstrating the greatest invention in a decade and they were giving it
away for free.
It wasn’t unprecedented. Lotus used to sell Lotus Improv for $199, and Microsoft borrowed
all of that technology and gave it away on the Excel data menu back in 1993. Of course, it
would have been a blatant rip-off if they would have put “Improv” on Data menu in Excel
5, so they changed the name to something called a “pivot table.”
Pivot tables were the greatest computing invention since VisiCalc, and Microsoft bundled
that for free with their Excel product.
I was watching the greatest computing invention since pivot tables, and now Microsoft was
planning on bundling it for free with Excel 2010.

This Book Was Pitched Eight Hours Later
Based on the two facts: (a) 100 million rows in Excel and (b) a pivot table from multiple
worksheets without a VLOOKUP, I knew that I wanted to write a book about this new
product. Loretta Yates from Que was in town for the MVP Summit, and I had tentative
approval for this new book less than eight hours after I saw the product.

There Could Be Five Titles for This Book
Any one of these mega-benefits would make PowerPivot worthy of a book:
■ 100 Million Rows: Miracle Product Allows Unlimited Rows in Microsoft Excel!
■ VLOOKUPs Shrugged: Why You Don’t Need VLOOKUPs Any More
■ ATOM & CSV: The Marriage of Disparate Data
■ L.Y. Actuals & C.Y. Budget: How Named Sets Enabled the Obvious But Previously Impossible
Pivot Table Report
■ Calculated Fields: Designed by an Intern? How DAX is Empowering Real Calculations in
Pivot Tables
This sixth title might not appeal to the Excel audience, but would make a great whitepaper:
■ Store It Columnwise, Stupid! How to achieve world-class data compression

There Could Be Five Titles for This Book
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At that first meeting with Donald Farmer, only the first two points really sunk in with me.
(1) They had busted through the one million row limit in Excel. (2) You could join Sheet1
and Sheet2 without VLOOKUP.
There are other benefits to PowerPivot that I did not begin to understand until I was working on these books, including the following:
■ PowerPivot can consume data from many places and present them all in the same
workbook. You can have low-tech data like flat text files. You can have data coming
from SQL Server. You can have data from Excel. Data from Access. RSS feeds.
■ All pivot tables are lousy at handling asymmetric reports. If you try to show last year’s
sales and this year’s budget in the same pivot report, you are going to have to endure
having last year’s budget and this year’s actuals in the report, too. This means you will
manually be hiding some columns and replacing the built-in total column with your
own column. The Excel team fixed this in Excel 2010, but only for people reporting
from OLAP data sets. Here is the funny thing about PowerPivot: It makes regular
Excel data into OLAP data sets. Saying that you want to use PowerPivot just to enable
asymmetric reporting is like saying that you want to use a $100 million laser to heat up
your coffee. It is a huge underutilization of a $100 million laser. But...the fact is that
the laser will heat up coffee, and you’ve frankly been living without a microwave since
1993 when the first pivot table hit Excel. So, if you have a need to report last year’s
actuals next to this year’s budget, well, PowerPivot is going to enable this for you.
■ Calculated fields in pivot tables were always sort of quirky. They would work for simple
things. When you see how the new DAX formula language enables you to do really
powerful things with calculated measures in PowerPivot, you will realize that calculated
fields can’t hold a candle to these new calculations.
Any one of those benefits should be enough to get the Excel data analyst to want to
upgrade to Excel 2010. Put all of the benefits into a single product, and price that product
at the price of $Free and there will be a lot of Excel people who should be drooling.
To see a demo of the benefits of PowerPivot, search for PowerPivot Data Analyst 1 at YouTube.

Who Are Those Other People in the Room?
There are at least three audiences who are watching PowerPivot with great interest:
■ There is us. You know us:You. Me. Excel people. We do everything in Excel. We
think that Microsoft Word is a useless add-in for people who can’t manage to use Edit,
Fill, Justify. We are the front lines of the decision-making process.
■ There are SQL Server people:They are the people who are sitting on top of 100 million rows of transactional data. They are the people who get us the nice and tidy one
million row summaries of the transactional data. (Between you and me, if they embrace
PowerPivot and just let us get to that 100 million rows of transactional data, we can
actually run a few different iterations before we figure out what data we actually need.)
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Introduction
■ There are SharePoint people:SharePoint people keep talking about having “one
version of the truth” and it is stored in SharePoint. The SharePoint people like
PowerPivot because if you and I design a cool report in PowerPivot, we can publish it
to SharePoint and that helps to justify why the company needs SharePoint.
I have to tell you, it is a little bit uncomfortable being in the same room with all these
people because frankly, our relationship had been a little adversarial over the years.
PowerPivot is in a sweet spot between these three groups.
The SQL Server people will actually have less requests from the Excel people. Get us the
data and we will slice and dice it.
The SQL Server people feel like they have more control because they get to make sure that
the original link to the data is to data that they bless. Also, the relationships in PowerPivot
help to make sure that the Excel people don’t screw up the data.
The Excel people can iterate over various attempts at producing reports without having to
go back to the SQL Server people in IT. It gets expensive buying a dozen chocolate Krispy
Cream donuts every time you need a new report from the IT department.
For the Excel people, if the SharePoint people will host our reports, we’ve secretly
offloaded the need to refresh the report every night because the SharePoint people can
schedule a nightly refresh. That means that we can spend a week at the beach without
having to dial in every morning to run the reports.
For the SharePoint people, you can see which reports are being accessed and by whom.
Those Excel people create a boatload of reports and there are probably two or three that
are actually used by the big important people in the company. With SharePoint, you can
see which reports are actually getting traffic and thus know which reports you should (a)
make sure don’t go down, and (b) know which reports are good candidates for turning into
other systems.

This Book Is For The Excel People
I have configured exactly one SharePoint server in my lifetime, and that was with a lot of
hand holding from a write-up by Vidas Matelis on the Web. I’ve installed SQL Server three
times, and only two of those installations were successful. (I still can’t figure out what I did
wrong with the third installation.)
If you are a SharePoint person or a SQL Server person, I don’t have a clue about the things
you are talking about. I know that you both have an interest in PowerPivot, and I hope that
Rob Collie or someone writes a book for you. My goal is to get those Excel people up to
speed with PowerPivot. I realize that the three groups of people can have a great symbiotic
relationship with PowerPivot. I hope to deliver the Excel masses to your door, clamoring
for access to your SQL Server data and your SharePoint servers.

Conventions Used in This Book
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How This Book Is Organized
I am writing this book for the Excel audience (the 500 million people who use Excel day in
and day out). All but one chapter will be focused on using the PowerPivot client inside of
Excel 2010.
The first two chapters gets PowerPivot installed and show you what is possible with
PowerPivot.
Chapter 3 takes a look at the upsides and downsides to using PowerPivot.
Chapters 4 through 6 cover how to get your data into PowerPivot, how to define relationships, and how to work with data before it becomes a pivot table.
Chapters 7 through 9 deal with the process of creating and using pivot tables with
PowerPivot.
Chapters 10 and 11 deal with the really powerful ways to use Data Analysis Expression
(DAX) measures.
Chapters 12 and 13 cover how to format your PowerPivot reports.
Chapter 14 identifies the benefits of using the server version of PowerPivot.
The appendix offers a list of additional resources.

Conventions Used in This Book
The special conventions used throughout this book are designed to help you get the most
from the book as well as Excel 2010.

Text Conventions
Different typefaces are used to convey various things throughout the book. They include
those shown in Table I.1.

Table I.1 Typeface Conventions
Typeface

Description

Monospace

Screen messages and web addresses appear in monospace.

Italic

New terminology appears in this italic.

Bold

References to text you should type appear in bold.

Tab names on the Ribbon, dialog box names, and dialog box elements are capitalized in this
book (for example, Add Formatting Rule dialog, Home tab).
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Introduction
In this book, key combinations are represented with a plus sign. If the action you need to
take is to press the Ctrl key and the T key simultaneously, the text tells you to press Ctrl+T.
There were not many changes from Excel 97 to Excel 2000 to Excel 2002 to Excel 2003.
Most people upgrading to Excel 2010 will be coming from one of these versions of Excel. I
collectively refer to these versions as “Legacy versions of Excel.”

Special Elements

NOTE

Tips point out special features, quirks, or software tricks that will help you increase your productivity
with Excel 2010.

TIP

Throughout this book, you’ll find tips, notes, cautions, cross-references, and case studies.
These elements provide a variety of information, ranging from warnings you shouldn’t miss
to ancillary information that will enrich your Excel experience but isn’t required reading.

Notes contain extra information or alternative techniques for performing tasks..

CAUTION
Cautions call out potential gotchas.

In most chapters, a YouTube video demo will be available for one topic.

Cross References
➞ See Chapter 9, “Cool Tricks New with PowerPivot,” for more information.

C A S E S T U DY: OT H E R E L E M E N T S
Case studies are set off in boxes such as this one:
Case studies walk you through the steps to complete a task.

Sidebars
Historical glimpses and other information that is not critical to your understanding appear as sidebars. I imagine that if
the Cliff Claven character from Cheers knew a lot about Excel, these would be the kinds of things he would write.

The Promise of PowerPivot
This chapter walks you through one process of
building a PowerPivot report. You will learn how
simple it is to merge data from two sources in a
single PowerPivot pivot table.
You can download these data sets from http://www.
MrExcel.com/powerpivotbookdata.html.
Before trying these steps in this chapter, make
sure that you have installed the PowerPivot client in Excel 2010 as described in Chapter 1,
“Downloading and Installing PowerPivot.”
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Preparing Your Data for PowerPivot
If you are using your own data in PowerPivot, you
need to ensure that your data is formatted appropriately. PowerPivot can deal with many different
types of data. But unfortunately, people and software vendors do a lot of weird stuff with their data.
One of my favorite large data sets comes from a
cash register vendor. They produce these large 1.8
million row data sets as flat text files and send them
to my client every day.
In Figure 2.1, you can see the top of the data set.
Row 1 contains the words “Run for:” and the date.
Row 2 is blank. Row 3 has headings. Row 4 has
underscores. Seriously? Underscores? Who are
those really for?
PowerPivot cannot deal with three of those first
four rows. PowerPivot can deal with the field
headings, but the Run For, the blank row, and the
underscores have to go. This either means a request
sent to the software vendor or a daily trip through
Notepad to delete those rows.
If you want PowerPivot to treat a column as a date
column, then 100% of the values in that column

Build a Pivot Table........................................26
World-Class Data Compression ......................31
Asymmetric Reporting with PowerPivot .......33
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Figure 2.1
PowerPivot has no problem with 1.8 million rows,
but it can’t deal with the
extra rows at the top.

have to be dates. This same vendor loves to use dates of **/**/**** for new items that are
not yet in inventory.

2

The point is that any date is going to have strange characteristics that you will have to deal
with. Work the IT department or your vendor to get the data cleaned up for PowerPivot.
In Figure 2.2, removing three headings solves the problem.

Figure 2.2
One row of headings, followed by data records.

If your data is in Excel, you want to follow the same format. One row of headings followed
by data rows. No blank columns. No blank rows. Make sure that any date columns are
100% filled with dates.
In the text file, there is only a store number. It would be nice to add store name, region,
and so on. In Figure 2.3, a small 150-row data set provides information about each store.

Figure 2.3
Identifying information
for each store.

Getting Your Data into PowerPivot
In this example, you will be importing two different data sets into PowerPivot. You will be
importing the text file. For the Excel data about the stores, you can either copy and paste
into PowerPivot, or define a table and link it to PowerPivot. For this example, a simple
copy and paste will work.
➞ See Chapter 4, “Getting Your Data into PowerPivot,” for details on using the linked table method.

Getting Your Data into PowerPivot
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Decide on a Sequence for Importing
You should import the main transaction table first. In this case, the main transaction table
is the 1.8 million row file with sales information. After that file is imported, you can import
the lookup table information.
You should follow this sequence for two reasons:
■ In the PowerPivot Field List, the tables are presented in the order that they were
imported. You will want your main table at the top of the list when building pivot
tables.
■ The PowerPivot relationship detection logic expects the main table to be first.
So, for this example, you will be loading the text file first, and then pasting the stores data
into PowerPivot.

Import a Text File
To import the 1.8 million row file into PowerPivot, follow these steps:

1. Select the PowerPivot tab in Excel 2010.
2. Select the PowerPivot Window icon. A new PowerPivot application window will
appear. PowerPivot offers two ribbon tabs: Home and Design. The left side of the
Home tab is shown in Figure 2.4.

Figure 2.4
The Home tab of the
PowerPivot application.

3. You want to import your main table first. This will be the large CSV file shown in
Figure 2.2. From the Get External Data group, select From Text. PowerPivot shows
the Table Import Wizard (see Figure 2.5).

4. Because your first row of the file contains headers, select the Use First Row as Column
Headers check box.

5. Click the Browse button and locate your text file. PowerPivot will pause for a second
and fetch the first 50 rows of data from the text file to provide a data preview, as shown
in Figure 2.6.

6. If there are any columns that you don’t need to import, clear them.

2

20

Chapter 2

The Promise of PowerPivot

Figure 2.5
Preparing to import a
text file.

Figure 2.6
PowerPivot provides a
50-row preview.

NOTE

2

The entire file is going to be read into memory. If you have extraneous columns, particular columns
with long text values, you can save memory by clearing them.

7. Note that there are filter drop-downs for each field. You can actually sort and filter this
1.8 million row data set here, although it will be slower than in a few steps from now. If
you open a filter field, PowerPivot will scan the entire file to build the list of filters, as
shown in Figure 2.7. You can choose to exclude certain values from the import.

8. Click Finish and PowerPivot will begin loading the file into memory. The wizard will
show how many rows have been fetched so far (see Figure 2.8). Loading data can take a
long time. If you would need to interrupt the import, the Stop Import button is available at the bottom of the wizard.

9. When the file is imported, the wizard confirms how many rows have been imported, as
shown in Figure 2.9. Click Close to return to the PowerPivot window.

Getting Your Data into PowerPivot
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Figure 2.7
To conserve file size, you
can choose to exclude
certain divisions from the
import.

2

Figure 2.8
PowerPivot provides
an update on how the
import is progressing.

Figure 2.9
These 1.8 million rows
are now stored in your
Excel file.

10. The 1.8 million row data set is shown in the PowerPivot Window. Go ahead. Grab the
vertical scrollbar and scroll through the records. You can also sort, change the number
format, or filter (see Figure 2.10).
To see a demo of importing data, search for PowerPivot Data Analyst 2 at YouTube.

Figure 2.10
1.8 million records are
in a grid that feels a lot
like Excel.
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Note that although this feels like Excel, it is not Excel. You cannot edit an individual cell. If you add a
calculation in what amounts to cell F1, that calculation will automatically get copied to all rows. If you
format the revenue in one cell, all of the cells in that column will get formatted. You can change column
widths by dragging the border between the column names just like in Excel.

The filters in PowerPivot are not as powerful as the new filters introduced in Excel 2007.
In particular, the date columns do not show a hierarchical filter where you can choose a
year or month.
If you right-click a column heading, a menu appears where you can rename, freeze, copy,
hide, unhide the columns (see Figure 2.11).
Bottom line: You have 1.8 million records that you can sort, filter, and later, pivot. This is
going to be cool.

Figure 2.11
Right-click a column to
rename it.

Add Excel Data by Copying and Pasting
Next, you want to add your store information to PowerPivot. As mentioned previously, you
could either link to the Excel data or copy and paste. For this example, a simple copy and
paste will work.
➞ See Chapter 4 for more information on linking.

To return to the Excel workbook from PowerPivot, you can press Alt+1 or click the tiny
Excel icon at the top left of the PowerPivot window (see Figure 2.12).

1. Open the StoreInfo.xslx file in Excel.
2. Select the data with Ctrl+*.
3. Copy it with Ctrl+C.
4. Click the PowerPivot Window icon. PowerPivot returns and you see your 1.8 million
row data set.

Define Relationships
Figure 2.12
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Switch to Workbook

Use this icon to return to
your Excel workbook.

5. Click the Paste icon on the left side of the PowerPivot Home tab. You will see a Paste
Preview window.

6. Give the new table a better name than Table. Perhaps StoreInfo (see Figure 2.13).
Click OK.

Figure 2.13
Give the pasted table a
name.

You will now see the store information in a new StoreInfo tab at the bottom of the screen.
Notice that there are now two worksheet tabs in PowerPivot, as shown in Figure 2.14.

Define Relationships
Normally, in regular Excel you would be creating VLOOKUPs to match the two tables. It
is far easier in PowerPivot. Follow these steps:

2
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Figure 2.14
You now have two
unrelated tables in the
PowerPivot window.

2

Demo tab
StoreInfo

1. You will be linking from one column in your main table to a column in another table.
To simplify the relationship process, navigate to your main table and select a cell in the
column from which you will be linking.

2. Click the Design tab in the PowerPivot Ribbon.
3. Select Create Relationship. The Create Relationship dialog appears. By default, the
selected table and column will appear in the first two fields, as shown in Figure 2.15.

4. If you skipped step 1 and the correct table is not shown in the Table drop-down, then
select Demo from the Table drop-down.
Create Relationship

Figure 2.15
Define a relationship
between tables. By selecting the key column before
starting, 2 of the 4 fields
are populated.

Add Calculated Columns Using DAX
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5. If you did not select the correct column in step 1, open the Column drop-down. Select
StoreID.

6. Open the Related Lookup table drop-down. Select StoreInfo.
7. Open the Related Lookup Column drop-down and select Store (see Figure 2.16).
Figure 2.16
This simple dialog
replaces the VLOOKUP.

2

8. Click Create. You’ve now created a relationship between the two tables.

Add Calculated Columns Using DAX
One downside to pivot tables created from PowerPivot data is that they cannot automatically group daily data up to years. Before building the pivot table, let’s use the Data Analysis
Expression (DAX) formula language to add a new calculated column to the Demo table.
Follow these steps to add a Year field to the Demo table:

1. Click the Demo worksheet tab at the bottom of the PowerPivot Window.
2. The column to the right of Revenue has a heading of Add Column. Click in the first
cell of this blank column.

3. Click the fx icon to the left of the formula bar. The Insert Function dialog appears with
categories for All, Date & Time, Math & Trig, Statistical, Text, Logical, and Filter.
Select Date & Time from the drop-down. You will instantly notice that this is not the
same list of functions in Excel. Five of the first six functions that appear in the window
are exotic and new (see Figure 2.17).

4. Luckily, some familiar old functions are in the list as well. Scroll down and select the
YEAR function. Click the first date in the Date column. PowerPivot proposes a formula of =year(demo[Date]. Type the closing parentheses and press Enter. Excel will fill
in the column with the year associated with the date, as shown in Figure 2.18.

5. Right-click the column and select Rename Column. Type a name, such as Year.
6. Repeat the process to add a Month column using a formula of =Month(demo[Date]).
Figure 2.19 shows the table after adding two columns.
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Figure 2.17
DAX offers a different list
of functions than Excel.
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Figure 2.18
A new calculated column
is added. You will want to
rename this.

Figure 2.19

TIP

You now have years and
months.

The language used to create that column is called DAX. There are two types of calculations that you can
do with DAX. Figure 2.19 shows a DAX calculation in the data grid. A more powerful type of DAX calculation is adding a DAX Measure to a pivot table.

➞ See Chapter 10, “Using DAX for Aggregate Functions” and Chapter 11, “Using DAX for Date Magic,” for
more information on DAX.

There are many more columns that you might think of adding, but let’s move on to using
the pivot table.

Build a Pivot Table
One of the advantages of PowerPivot is that multiple pivot tables can share the same data
and slicers. Open the PivotTable drop-down on the Home tab of the PowerPivot Ribbon.

Build a Pivot Table
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As shown in Figure 2.20, you have choices for a single pivot table, a single chart, a chart
and a table, two charts, four charts, and so on.
➞ To read more about layouts with multiple elements, see Chapter 7, “Building Pivot Tables.”

Figure 2.20
You have many options
beyond a single table or
chart.

2

Follow these steps:

1. Select PivotTable. You now see the PowerPivot tab back in the Excel window.
2. Choose to put the pivot table on a new worksheet (see Figure 2.21).

Figure 2.21
Choose the location for
the pivot table.

There are many things to notice. The icon for a blank pivot table occupies cell B3:D20.
This allows room for slicers to go above and left of the pivot table (see Figure 2.22).

NOTE

Docked on the right side of the screen is the PowerPivot Field List. This is now a third
variation of the PivotTable Field List.

Excel already offers two different field lists, one for OLAP data sets and one for PivotCache data sets.
Figure 2.23 shows the PowerPivot Field List.
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Figure 2.22
The blank pivot table icon
appears in B3.
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Figure 2.23
The PowerPivot Field List
is a third variant of the
PivotTable Field List.

Click to Expand

Two Slicer
Drop Zones

Both tables are available in the top of the Field List. The main table is expanded to show
the field names, but you can expand the other table and add those fields to this pivot table.

NOTE

Two new sections in the drop zones offer vertical or horizontal slicers.

For the purposes of the screen shots in this book, I will undock the PowerPivot Field List and float it
near the pivot table. To undock the field list, grab the title bar and drag away from the edge of the
screen. To later redock the field list, grab the title bar and drag it more than half way off the right side
of the Excel window.

Because you are in a pivot table, the PivotTable Tools tabs are available in the Excel Ribbon.

Build a Pivot Table
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3. Select Revenue from the PowerPivot Field List by adding a check box next to it.
Because Revenue is a numeric field, it automatically moves to the Values drop zone at
the bottom of the field list. Your pivot table now shows Sum of Revenue, which is the
total revenue in the entire 1.8 million row file (see Figure 2.24).

Figure 2.24
Choose a numeric field
and Excel sums that field.

2

4. Expand the StoreInfo table. Select Region from the StoreInfo table. Excel builds a
pivot table showing sales by region. At this point, you have a pivot table from 1.8 million rows of data with a virtual link to a lookup table.

5. Drag the Division field from the Demo table to the Column Labels drop zone.Your
pivot table is now mashing up data from two different tables (see Figure 2.25).

Figure 2.25
This pivot table summarizes 1.8 million rows and
data from two tables.

6. Drag the Store Name field to the Row Labels drop zone. Drop Store Name below the
Region field.
To show off some more features of the PowerPivot pivot table, let’s add some slicer functionality:
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1. Drag Year to the Slicers Vertical drop zone.
2. Drag Month to the Slicers Vertical drop zone.
3. Drag Mall Developer to the Slicers Horizontal drop zone.
To clean up the formatting of the pivot table, follow these steps:

1. Go to the PivotTable Tools Design tab in the Ribbon. Select Banded Rows.
2. On the same tab, open the PivotTable Styles gallery and choose a light, medium, or
2

dark color scheme.

3. Go to the Options tab. The Active Field should say Sum of Revenue. If it does not,
choose a numeric cell in the pivot table.

4. Click the Field Settings icon in the PivotTable Tools Options tab.
5. In the lower left corner of the Value Field Settings dialog, select the Number Format
button.

6. Select the Number category. Select Use 1000 Separator. Select 0 decimal places (see
Figure 2.26). Click OK to close the Format Cells dialog. Click OK to close the Value
Field Settings dialog.

Figure 2.26
The numeric formatting is
hidden two levels deep.

The result is an impressive interactive report, as shown in Figure 2.27.

Figure 2.27
The formatted report
with some slicers.

World-Class Data Compression
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7. Select the year 2000 from the Year slicer. The report instantly redraws to show only
the stores that were open in the year 2000. The Mall Developer slicer redraws to show
only the five developers with whom you had contracts in 2000 (see Figure 2.28).

World-Class Data Compression
When you are creating PowerPivot data sets, all of the data is loaded into computer memory. When you save a PowerPivot workbook, the data from the imported text files is stored
in the workbook. Amir Netz from the PowerPivot team came up with an impressive methodology for compressing the data.
Figure 2.28 tells an impressive story. This chapter mashed up a text file that occupies
58MB. It also incorporated the StoreInfo.xlsx file which takes up 19K. All of that data is
stored in the StoreMashup.xlsx file in an amazingly small 3.6MB file (see Figure 2.29).

Figure 2.28
Choose a year and the
report updates, as well as
the other slicers.

Figure 2.29
58MB of text file fits in a
3.6MB Excel file.

Storing Data Columnwise
When you are storing a database on a medium like a hard drive, it makes sense to keep each record together. Because
hard drives are relatively slow, you want that data stored in a contiguous block as shown in Figure 2.30.
Figure 2.30
In a traditional diskbased database, all of the
fields for one record are
stored in close proximity
to each other.

2
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The problem with storing data in a row-wise fashion is that there is little opportunity for compression. In the entire 1.8
million rows of the text file, there are no records that match 100%.
Early on, the PowerPivot team decided that PowerPivot was only going to be dealing with data in memory. Thus, they
don’t need to store data in a row-wise fashion.
When you start to look at a single column of data, there are many columns with huge amounts of duplicates. For example, 1.8 million rows of category information really only has nine possible values. There are massive numbers of adjacent
values that are exactly the same see Figure 2.31).
Figure 2.31
Look at one column of
the data, and there are
many possibilities for
compression.

If you sort the data by category, you really end up with huge rainbow stripes of records that fit in each category (see
Figure 2.32). The space to store the entire column of 1.8 million category values comes down to 9 pointers that say
everything from this record to this records is “Jewelry.”
Figure 2.32
Conceptually, PowerPivot
is reducing the data to
rainbow stripes of different values in each
column.

Microsoft calls this VertiPaq compression. (That is kind of a catchy name, isn’t it. Vertical packing of the data. Geeky.)
This is why PowerPivot does not do well with long text values in a column. If you have a comment field, remove that
field as you are importing the data to allow PowerPivot to do its full compression.

NOTE

2

Microsoft is cautiously saying that they might sometimes see 15X compression. The simple example in
this chapter was not designed to compress extremely well, but it does demonstrate a 16X compression
factor.

Asymmetric Reporting with PowerPivot
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I hate to extrapolate, but if the file size limit is 2GB on disk, and if you could somehow keep up the 16X compression,
then that is a theoretical maximum of 32GB of data in a single pivot table. That would be 993 million rows of demo.txt
type data. You would have to own a serious computer. 64-bit Windows and 64-bit Office to be sure.
Most of us were limited to 65,536 rows just a year or two ago. Now the simple demo file for this book is 27 times larger
than that limit, with a theoretical upper limit that is 15,000 times larger than 65,536 rows. I would gladly personally
shell out the full purchase price of the PowerPivot client to get access to that much analytical power.

Asymmetric Reporting with PowerPivot
Asymmetric reporting is not possible with pivot tables that are built from pivot caches of
Excel data. In Figure 2.33, a small data set in A1:D37 is used to produce the pivot table in
columns G:N.

Figure 2.33
Delete those five columns
from the report.

Out of seven data columns in the report, you don’t want to see five of them. You are interested in last year’s actuals and this year’s forecast. This is not really possible with a regular
pivot table.
You could use PivotTable Tools Options, Options, Totals & Filters, and then clear Show
Grand Total For Rows to get rid of the grand total in column N.
Then, you can click a year heading in the pivot table, use PivotTable Tools Options, Field
Settings and select None for the Subtotals to get rid of two more columns. But then, you
are left with no good way to delete 2009 Budget or 2010 Actuals. If you try to filter out the
Budget, it will be removed from both years. If you try to delete column I, you will be met
with the warning that you cannot Move a Part of A Pivot Table report message (see Figure
2.34).
Option 1 is to use Home, Format, Column, Hide to hide the columns that you don’t want
to see. Option 2 is to convert the pivot table to values using Copy and then Paste, Paste
Values.
With PowerPivot, a third option becomes available. Because data in the PowerPivot window becomes an online analytical processing (OLAP) cube, you have access to OLAP tools,
including named sets.
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Figure 2.34
You can get close using
regular pivot table tools,
but then you are shut
down.

2

Follow these steps to create an asymmetric report:

1. Open your regular data set in Excel.
2. Select one cell in the data and press Ctrl+T. Confirm that your data has headings. Click
OK. The data is formatted and a new Table Tools Design tab appears. On the left side,
the Table Name appears as Table 1. Type a new name, such as Financials.

3. On the PowerPivot tab, select Create Linked Table.
4. In the PowerPivot Window, open the Pivot Table drop-down and select Pivot Table.
5. Choose a location for the pivot table.
6. Select State and Revenue from the Pivot Table Field List. Drag Year and Measure to
the Column Labels drop zone.

7. You now have a pivot table that looks identical to the one in Figure 2.33. The difference is that Named Sets are not grayed out anymore on the Options tab.

8. Go to PivotTable Tools Options. Open the Fields, Items, and Sets drop-down. Select
Create Set Based on Column Items.

9. Type a set name, such as BudAct. The Display Folder can be blank. Excel shows you
the 7 columns currently in your pivot table.

10. Select the row for FY2009 Budget, as shown in Figure 2.35. Click Delete Row.
11. Repeat step 10 for the other four rows that you don’t want to show in the pivot table.
When you are done, you should see only two rows, as shown in Figure 2.36.

12. Click OK to complete the set.
As shown in Figure 2.37, you will now have a pivot table that will report asymmetric sets of
columns.

Next Steps
This chapter showed you what is possible with pivot tables. In the next chapter, you will see
both the benefits of the drawbacks of using PowerPivot.

Asymmetric Reporting with PowerPivot
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Figure 2.35
Select a pair of values and
click Delete.

2

Figure 2.36
Repeat for each item that
you want to delete.

Figure 2.37
This pivot table would
be very difficult to create
without PowerPivot.
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Symbols
32-bit PowerPivot version,
9–10
64-bit PowerPivot version,
9–10
& (ampersand) operator,
132–133

A
ABS function, 123, 129
active cell, hiding, 281
adding. See inserting

asymmetric pivot tables,
building with named sets,
39–40
asymmetric reporting,
33–34, 256–258

BLANK function, 140–141

autodetecting relationships,
85–88

Boolean data type, 102

AutoLayout mode (slicers),
41, 208
AVERAGE function,
226, 239
AVERAGEA function, 227,
239

ALLEXCEPT function,
237–239

B

ampersand (&) operator,
132–133

Blank data type, 102–104

blanks in Values area,
160–161

AVERAGEIFS function, 228

ALLNONBLANKROW
function, 238–239

base items, 188–189

Atom feeds, importing data
from, 83

advantages
of PowerPivot, 38–44,
58–60
of PowerPivot Server,
286–287

ALL function, 230–240

base fields, 188–189

AVERAGEX function, 144
axis line, deleting, 275–276

background color
(of reports), changing, 280
back worksheets, moving
pivot tables to, 211–212

AND function, 140–141

banners, adding to reports,
282–284

appended data, handling
improper data in, 73–74

bar charts, category charts
as, 269

Boolean logic functions, 141
bottom row color,
changing, 281
bounding rectangle for
slicers, resizing, 206–207
building
concatenated key
relationships, 95–97
pivot charts, 169–172
pivot tables, 26–31, 152–162
Compact Layout,
162–166
data set for, 152–153
dragging from field list
to drop zone, 158
from multiple tables,
38–39
mapping text and
numeric fields, 155–157
with named sets, 39–40
Report Filter, 159–161
Report Filters versus
slicers, 161–162
troubleshooting,
160–161
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building

reports
arranging field
headings, 150
with PowerPivot Field
List, 150–152

C
calculated columns, 25–26,
110. See also DAX,
functions
calculated fields, 43–44, 52,
218. See also DAX,
measures
CALCULATE function,
239–241
Sales department example,
232–233
shortcut for, 234
SUMIFS function versus,
228–230
when not to use, 249–250
CALCULATETABLE
function, 144
calculating
between pivot tables, 89–90
conditional calculations,
140–141
count distinct, 220–225
COUNTROWS
function, 221
DISTINCT function,
220–221
DAX measures, 225
factorials, 129
logarithms, 129–130
magnitude of error, 129
period-to-date
calculations, 245
quotients and remainders,
127–128
roots and powers, 127

sales
for full month/quarter/
year, 246
for previous 30 days, 247
for previous month/
quarter/year, 247
calculations, changing,
46–49, 184–189
calendar quarters, fiscal
years and, 244–245
case
converting, 133
matching, 138–139
in relationships, 98
category charts, 269
CEILING function,
123–127
cell pointer, hiding, 281
cells
double-clicking, 52–53
editing, 49
changing
background color
(of reports), 280
bottom row color, 281
calculations, 46–49,
184–189
column widths, 107–108
Compact Layout, 162–166
label scale, 271–272
numeric formatting,
190–192
part of pivot tables, 167–169
pasted data, 74–75
report titles, 269–270
Show Values drop-down,
187–188
character numbers,
determining, 133–134
charts. See pivot charts

CLOSINGBALANCEMONTH function,
242, 249
CLOSINGBALANCEQUARTER function,
242, 249
closing balances, functions
for, 249
CLOSINGBALANCEYEAR
function, 242, 249
CODE function, 130,
133–134
color
background color
(of reports), 280
bottom row color, 281
contrasting in reports,
280–281
defining in styles, 194–197
of slicers, 278
Column Labels fields, 149
columns
calculated columns, 110.
See also DAX, functions
deleting, 109
freezing, 107
hiding, 108
increasing width of, 276
inserting with DAX
formulas, 110–112
labels, 162–166
rearranging, 106–108
resizing, 107–108
columnwise data storage,
31–33
Compact Layout, changing,
162–166
comparisons, sales
comparisons by date,
245–246

DATESINPERIOD
component charts as pie
charts, 268

COUNTROWS function,
221, 239

compressing data, 31–33, 39

counts, forcing, 184–185

concatenated key
relationships, 95–97

COUNTX function, 144

CONCATENATE function,
131–133
conditional calculations,
140–141

Create Linked Table
icon, 12
creating. See building
cube files, 172–173

context menu, 109

cube formulas, converting
pivot tables to, 168–169,
263–266

contrasting color and title in
reports, 280–281

customers, sorting by sales,
175–179

converting
case, 133
data to tables, 62–67
pivot tables to cube formulas,
168–169, 263–266
pivot tables to formulas, 43
pivot tables to values, 168
text to numbers, 139

custom lists, sorting pivot
tables, 179–182

conditions, testing, 141

CY data type, 102

from SQL Server, 79–80
text files, 19–22, 80–82
data labels, inserting,
274–275
data preparation, 17–18
data sets, 152–153
data sheet view, 101–109
context menu, 109
deleting columns, 109
filtering data, 104–106
hiding columns, 108
numeric formatting,
applying, 102–104
printing, 106
rearranging columns,
106–108
sorting data, 104
undo/redo, 109
data types (DAX), 102

D

data visualizations, 195–197
DATEADD function, 242

dashboard, formatting
reports as, 280–281

date and time functions
(DAX), 112–119

COUNTA function,
226, 239

Data Analysis Expression.
See DAX (Data Analysis
Expression)

Date data type, 102

COUNTAX function, 144

data compression, 31–33, 39

DATEDIF function, 96

COUNTBLANK function,
227, 239

data exports, 75–76

dates
date functions (DAX),
248–249
formatting, 132

copy/paste (importing data),
22–23, 67–76

count distinct, calculating,
220–225
COUNTROWS
function, 221
DISTINCT function,
220–221
COUNT function, 227, 239
COUNTIFS function, 228

data imports, 18–23, 61–84
from Atom feeds, 83
converting to table and
linking, 62–67
copy/paste, 22–23, 67–76
data sources supported,
83–84
from external workbooks,
76–79
sequence for, 19

DATE function, 112–114

DATESBETWEEN
function, 242
DatesInPeriod
function, 247
DATESINPERIOD
function, 242
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DATESMTD

DATESMTD function,
241–242
DATESQTD function, 242
DATESYTD function, 243
DATEVALUE function,
112–114
DAX (Data Analysis
Expression), 217
calculated columns,
inserting, 25–26
data types, 102
functions
ALL, 230–240
ALLEXCEPT, 237–238
CALCULATE, 228–233
COUNTROWS, 221
date and time functions,
112–119
date functions for
monthly data, 248–249
DISTINCT, 220–221
FILTER, 234–237
FORMAT, 96
information functions,
142
logical functions,
139–142
math and trigonometry
functions, 123–130
measure functions,
238–239
recursive functions,
145–146
RELATED, 90
summary functions,
226–228
text functions, 130–139
time intelligence
functions, 242–250
values from related
tables, 142–145
YEARFRAC, 96
inserting columns, 110–112

measures, 43–44, 110, 218
calculated fields
versus, 218
calculating on
demand, 225
changing, 184–189
creating, 222–224
filtering, 223–224
filters, 220, 226–234
function summary,
238–239
referencing other DAX
measures, 225
shortcut for
CALCULATE
function, 234
operators, 110–111
DAY function, 112, 116–117
December 30, 1899 result,
troubleshooting, 120–121
decimals, removing, 124–127

double-clicking cells, 52–53
drop zones
dragging from field list
to, 158
as filters, 219

E
EARLIER function, 145–146
EARLIEST function, 146
EDATE function, 112,
119–120
editing
cells, 49
GetPivotData formula,
49–51
slicers, 276–278
ENDOFMONTH
function, 243

defining
named sets, 251–253
relationships, 23–25,
88–89

ENDOFQUARTER
function, 243

deleting. See also uninstalling
axis line, 275–276
columns, 109
gridlines, 273–274
legends, 271
on-chart controls, 272
tick marks, 275
values axis, 275

EOMONTH function, 113,
119–120

Design tab, 15, 192–194
Detection icon, 12
disabling. See uninstalling
disadvantages of PowerPivot,
44–60
DISTINCT function,
220–221, 239

ENDOFYEAR function, 243

errors, testing for, 141–142
EXACT function, 131,
138–139
Excel 2010
benefits of, 2–5
copy/paste data sets
into, 106
PowerPivot system
requirements, 9–11
Starter Edition, 11
Excel Ribbon,
minimizing, 281
Excel Web App, 11

functions (DAX)
EXP function, 123, 129–130

fiscal years, 244–245

exporting data for editing,
75–76

FIXED function, 131, 139

external workbooks,
importing data from, 76–79

F
FACT function, 123, 129
factorials, calculating, 129
FALSE function, 140–141
feeds. See Atom feeds
field headings,
arranging, 150
field lists
dragging to drop zone, 158
undocking, 28
File tab, 13
FILTER function, 234–239
filtering
DAX measures, 223–224
in data sheet view, 104–106
multiple values from related
tables, 144
pivot tables, 182–184
with Report Filter, 159–162
filters
DAX measures and, 220,
226–228
drop zones as, 219
ignoring, 228–234
FIND function, 131,
135–137
FIRSTDATE function,
243, 248
FIRSTNONBLANK
function, 238–239, 243

flattened pivot tables,
165–166
FLOOR function, 123–127
forcing counts, 184–185
FORMAT function, 96,
131–132
formatting. See also layouts
numbers/dates, 102–104,
132, 139
pivot tables, 190–197
changing numeric
formatting, 190–192
colors, 194–197
Design tab, 192–194
reports, 267–284
axis line, deleting,
275–276
background color,
changing, 280
bottom row color,
changing, 281
category charts as bar
charts, 269
cell pointer, hiding, 281
columns, increasing
width of, 276
component charts as pie
charts, 268
contrast color and title,
280–281
data labels, inserting,
274–275
formula bar, hiding, 281
gridlines, deleting,
273–274
gridlines, hiding, 279
interface elements,
hiding, 279–280
label scale, changing,
271–272

legends, deleting, 271
on-chart controls,
deleting, 272
pictures as top banners,
282–284
pie charts, replacing
legends with
labels, 273
PowerPivot Field List,
hiding, 280
preserving with
GetPivotData formula,
258–263
ribbon, minimizing, 281
slicers, editing, 276–278
tick marks, deleting, 275
time series charts as line/
column charts, 268
titles, changing, 269–270
values axis, deleting, 275
zoom slider
adjustments, 281
formula bar, hiding, 281
formulas
calculating between pivot
tables, 89–90
converting pivot tables
to, 43
GetPivotData, 49–51,
258–263
inserting columns, 110–112
in tables, 65
freezing columns, 107
full month/quarter/year,
calculating sales for, 246
functions (DAX)
ALL, 230–240
ALLEXCEPT, 237–238
CALCULATE
Sales department
example, 232–233
shortcut for, 234
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functions (DAX)

SUMIFS function
versus, 228–230
COUNTROWS, 221
date and time functions,
112–119, 248–249
DISTINCT, 220–221
FILTER, 234–237
FORMAT, 96
information functions, 142
logical functions, 139–142
math and trigonometry
functions, 123–130
measure functions,
238–239
recursive functions, 145–146
RELATED, 90
summary functions,
226–228
text functions, 130–139
time intelligence functions,
242–250
values from related tables,
142–145
YEARFRAC, 96

G
generating random
numbers, 127
GetPivotData formula,
49–51, 258–263
grand total row,
correcting in named sets,
254–256
graphics as report banners,
282–284
gridlines
deleting, 273–274
hiding, 279
grouping in pivot tables,
53–55

H
handling improper data
in appended data, 73–74
in copy/paste data, 71–73
hiding
cell pointer, 281
columns, 108
formula bar, 281
gridlines, 279
interface elements, 279–280
PowerPivot Field List, 280
Home tab, 14
horizontal slicers, 203
HOUR function, 113,
116–117

I

improper data, handling
in appended data, 73–74
in copy/paste data, 71–73
In Figure 10.18, 232
information functions
(DAX), 142
inserting
calculated columns, 25–26
columns, 110–112
data labels, 274–275
records, 69–70
slicers, 203–208
top banners on reports,
282–284
installing PowerPivot, 11–15
interface elements, hiding,
279–280
INT function, 124–127
ISBLANK function, 142

I8 data type, 102

ISERROR function, 142

IFERROR function,
140–142

ISLOGICAL function, 142

IF function, 140–141
ignoring filters, 228–234
images as report banners,
282–284
importing data, 18–23,
61–84
from Atom feeds, 83
converting to table and
linking, 62–67
copy/paste, 22–23, 67–76
data sources supported,
83–84
from external workbooks,
76–79
sequence for, 19
from SQL Server, 79–80
text files, 19–22, 80–82

ISNONTEXT function, 142
ISNUMBER function, 142
ISTEXT function, 142
IT department, usage
of PowerPivot Server,
291–292

J-K-L
joining
pivot tables, 40. See also
relationships
text, 132–133
labels
data labels, inserting, 274–275
replacing legends with, 273

multiple values from related tables
label scale, changing,
271–272
LASTDATE function,
243, 248
LASTNONBLANK
function, 243
layouts
adding pivot charts to,
208–212
adding pivot tables to,
212–215
in PowerPivot, 199
slicers and, 199–200
two pivot charts, 200–203
LEFT function, 131,
134–135
legends
deleting, 271
replacing with labels, 273
LEN function, 131, 135
line/column charts, 268
Linked Table tab, 15
linking Excel tables to
PowerPivot, 62–67
LN function, 124, 129–130
LOG10 function, 124,
129–130
logarithms, calculating,
129–130
LOG function, 124,
129–130
logical functions (DAX),
139–142
lookup tables, unwinding,
91–95
LOWER function, 131, 133

M

MINA function, 227, 239

macros. See VBA

minimizing Excel
Ribbon, 281

magnitude of error,
calculating, 129

MINUTE function, 113,
116–117

manually defining
relationships, 88–89

MINX function, 145

many-to-many
relationships, 98
mapping text and numeric
fields, 155–157

MOD function, 124,
127–128
MONTH function, 113,
116–117

matching case, 138–139

monthly data, date functions
(DAX) for, 248–249

math and trigonometry
functions (DAX), 123–130

month names, sorting,
44–46, 177–179

MAX function, 226, 239

moving
part of pivot tables,
167–169
pivot tables to back
worksheets, 211–212

MAXA function, 227, 239
MAXX function, 145
MDX (Multidimensional
Extensions), 217
measures (DAX), 43–44,
110, 218
calculated fields versus, 218
calculating on demand, 225
changing, 184–189
creating, 222–224
filtering, 223–224
filters, 220, 226–234
function summary, 238–239
referencing other DAX
measures, 225
shortcut for CALCULATE
function, 234

MROUND function,
124–127
Multidimensional Extensions
(MDX), 217
multiple conditions,
testing, 141
multiple consolidation range
pivot tables, 92
multiple pivot tables,
joining, 40. See also
relationships
multiple relationships, 98

Microsoft SQL Server
PowerPivot for Excel.
See PowerPivot

multiple tables, building
pivot tables from,
38–39

MID function, 131, 134–135

multiple values from related
tables, 143

MIN function, 226, 239
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named ranges

N
named ranges, 77
named sets
for asymmetric reports,
256–258
building asymmetric pivot
tables, 39–40
defining, 251–253
grand total row, correcting,
254–256
NAND function, 141
natural logarithms,
130, 147
navigating worksheets, 280

O
on-chart controls,
deleting, 272
OPENINGBALANCEMONTH function,
243, 249
OPENINGBALANCEQUARTER function,
243, 249
OPENINGBALANCEYEAR
function, 243, 249
opening balances, functions
for, 249

negative numbers, 126

operators (DAX), 110–111,
132–133

New Measures icon, 12

OR function, 140–141

NEXTDAY function, 243
NEXTMONTH
function, 243

P

NEXTQUARTER
function, 243

PARALLELPERIOD function, 244, 248

NEXTYEAR
function, 243

pasted data, changing,
74–75

NOR function, 141

period-to-date
calculations, 245

NOT function, 140–141
NOW function, 113–116
numbers
converting text to, 139
numeric formatting,
132, 139
applying, 102–104
changing, 190–192
in relationships, 99
numeric fields, mapping to
values, 155–157

pictures as report banners,
282–284
pie charts
component charts as, 268
replacing legends with
labels, 273
PI function, 124, 128
pivot charts. See also reports
adding to layouts, 208–212
building, 169–172
category charts, 269

component charts as pie
charts, 268
line/column charts, 268
on-chart controls,
deleting, 272
pie charts, replacing legends
with labels, 273
standalone pivot charts,
42–43, 211–212
two pivot charts layout,
200–203
width of columns, increasing, 276
pivot tables. See also
PowerPivot
adding to layouts, 212–215
building, 26–31, 152–162
Compact Layout,
162–166
data set for, 152–153
dragging from field list
to drop zone, 158
from multiple tables,
38–39
mapping text and
numeric fields, 155–157
with named sets, 39–40
Report Filter, 159–161
Report Filters versus
slicers, 161–162
troubleshooting,
160–161
calculated columns, 25–26
calculated fields, 52
calculating between, 89–90
calculations, changing,
46–49, 184–189
cells
double-clicking, 52–53
editing, 49
changing part of, 167–169
converting to cube formulas, 168–169, 263–266
converting to formulas, 43

quotients
converting to values, 168
elements of, 149–150
exporting data for editing,
75–76
filters
drop zones as, 219
Top 10 filter, 182–184
flattened pivot tables,
165–166
formatting, 190–197
changing numeric
formatting, 190–192
colors, 194–197
Design tab, 192–194
grouping in, 53–55
hooking to slicers, 210–211
joining, 40. See also
relationships
months, sorting, 44–46
moving to back worksheets,
211–212
records, inserting, 69–70
refreshing, 166–167
relationships
autodetecting, 85–88
concatenated key
relationships, 95–97
defining, 23–25
defining manually,
88–89
troubleshooting, 98–99
unwinding lookup tables,
91–95
VLOOKUP function
versus, 98
Show Items with No Data
option, 51–52
Show Pages feature,
57–58
sorting, 175–182
by custom lists, 179–182
by month names,
177–179
customers by sales,
175–179

typing adjustments
on-worksheet, 55–57
VBA and, 49
POWER function, 124, 127
PowerPivot. See also pivot
tables
advantages of, 38–44, 58–60
asymmetric reporting,
33–34
benefits of, 2–5
data compression, 31–33, 39
data preparation for, 17–18
disadvantages of, 44–60
importing data into, 18–23,
61–84
installing, 11–15
layouts in, 199
ribbon tabs in, 12–15
system requirements, 9–11
uninstalling, 16
PowerPivot Field List
building reports, 150–152
cube files, 172–173
hiding, 280
PowerPivot Server
advantages of, 286–287
IT department usage,
291–292
reports
troubleshooting,
292–294
uploading, 287–288
viewing, 288–291
requirements, 285–286
PowerPivot tab, icons in,
11–12
PowerPivot window
data sheet view, 101–109
context menu, 109
deleting columns, 109
filtering data, 104–106
hiding columns, 108

numeric formatting,
applying, 102–104
printing, 106
rearranging columns,
106–108
sorting data, 104
undo/redo, 109
DAX formulas in, 111–112
PowerPivot Window
icon, 12
powers, calculating, 127
preparing data, 17–18
preserving report formatting
with GetPivotData
formula, 258–263
previous 30 days, calculating
sales for, 247
PREVIOUSDAY
function, 244
PREVIOUSMONTH
function, 244
previous month/quarter/
year, calculating sales
for, 247
PREVIOUSQUARTER
function, 244
PREVIOUSYEAR
function, 244
printing data sheet view, 106

Q
Quick Access toolbar, 15
QUOTIENT function, 124,
127–128
quotients, calculating,
127–128
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R8 data type

R
R8 data type, 102
RANDBETWEEN function,
124, 127
RAND function, 124, 127
random numbers,
generating, 127
ranges, named ranges, 77
rearranging columns,
106–108
recalculating. See refreshing
records, inserting, 69–70
recursive functions (DAX),
145–146
referencing DAX
measures, 225
refreshing
imported data, 78–79
pivot tables, 166–167
RELATED function, 90,
143–145
RELATEDTABLE function,
143–145
related tables, values from,
142–145
relationships
autodetecting, 85–88
calculating between pivot
tables, 89–90
concatenated key relationships, 95–97
defining, 23–25
defining manually, 88–89
troubleshooting, 98–99
unwinding lookup tables,
91–95

VLOOKUP function
versus, 98
remainders, calculating,
127–128
removing. See uninstalling
decimals, 124–127
trailing spaces, 133
renaming tables, 98
repeating text, 138
REPLACE function, 131,
137–138
replacing legends with
labels, 273
Report Filter, 150, 159–162
Report gallery, 288–291
reports. See also layouts;
pivot charts
asymmetric reporting,
33–34, 256–258
building
arranging field headings,
150
with PowerPivot Field
List, 150–152
formatting, 267–284
axis line, deleting,
275–276
background color,
changing, 280
bottom row color,
changing, 281
category charts as bar
charts, 269
cell pointer, hiding, 281
columns, increasing
width of, 276
component charts as pie
charts, 268
contrast color and title,
280–281

data labels, inserting,
274–275
formula bar, hiding, 281
gridlines, deleting,
273–274
gridlines, hiding, 279
interface elements,
hiding, 279–280
label scale, changing,
271–272
legends, deleting, 271
on-chart controls,
deleting, 272
pictures as top banners,
282–284
pie charts, replacing
legends with
labels, 273
PowerPivot Field List,
hiding, 280
preserving with
GetPivotData formula,
258–263
ribbon, minimizing, 281
slicers, editing, 276–278
tick marks, deleting, 275
time series charts as line/
column charts, 268
titles, changing, 269–270
values axis, deleting, 275
zoom slider
adjustments, 281
in PowerPivot Server,
troubleshooting, 292–294
layouts, 200–203
uploading to PowerPivot
Server, 287–288
viewing in PowerPivot
Server, 288–291
REPT function,
131, 138
requirements. See system
requirements

tables
resizing
bounding rectangle for slicers, 206–207
columns, 107–108
slicers, 204–206
ribbon
minimizing, 281
ribbon tabs in PowerPivot,
12–15
RIGHT function, 131,
134–135
roots, calculating, 127
ROUNDDOWN function,
124–127
ROUND function, 124–127
rounding numbers,
124–127
ROUNDUP function,
124–127
Row Labels fields, 149,
155–157

S
sales
calculating
for full month/quarter/
year, 246
for previous 30
days, 247
for previous month/
quarter/year, 247
sales comparisons by date,
245–246
sorting customers by,
175–179
SAMEPERIODLASTYEAR
function, 244

scale (in labels), changing,
271–272
SEARCH function, 131,
135–137
SECOND function, 113,
116–117
server version
of PowerPivot.
See PowerPivot Server
Show Items with No Data
option, 51–52
Show Pages feature, 57–58
Show Values drop-down,
changing, 187–188
SIGN function, 124–127
significance, negative numbers for, 126
slicers
AutoLayout mode, 208
bounding rectangle,
resizing, 206–207
editing, 276–278
inserting, 203–208
joining multiple pivot
tables, 40
layouts and, 199–200
PowerPivot AutoLayout, 41
Report Filter versus,
161–162
resizing, 204–206
sorting
in data sheet view, 104
months, 44–46
pivot tables, 175–182
by custom lists, 179–182
by month names,
177–179
customers by sales,
175–179

sparklines, 195–197
splitting text, 134–135
SQL Server, importing data
from, 79–80
SQRT function, 124, 127
standalone pivot charts,
42–43, 211–212
STARTOFMONTH
function, 244
STARTOFQUARTER
function, 244
STARTOFYEAR
function, 244
String data type, 102
styles, defining colors in,
194–197
SUBSTITUTE function,
131, 137–138
SUM function, 146–147,
226, 239
SUMIFS function,
228–230
summary functions (DAX),
226–228
SUMX function, 145
system requirements, 9–11,
285–286

T
tables
converting data to,
62–67
formulas in, 65
renaming, 98
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testing

testing
conditions, 141
for errors, 141–142
multiple conditions, 141
text
converting to numbers, 139
formatting numbers as, 139
joining, 132–133
numbers as, 99
repeating, 138
splitting, 134–135
text fields, mapping to row
labels, 155–157
text files, importing, 19–22,
80–82
TEXT function, 96, 132
text functions (DAX),
130–139
tick marks, deleting, 275
time and date functions
(DAX), 112–119
TIME function, 113,
121–122
time intelligence functions
(DAX), 242–250

top banners, adding
to reports, 282–284
TotalMTD function, 244
TotalQTD function, 244
TotalYTD function, 244
trailing spaces
in relationships, 99
removing, 133
trigonometry functions
(DAX), 123–130
TRIM function,
131–133
troubleshooting
blanks in Values area,
160–161
column labels, 162–166
date and time functions,
120–121
PowerPivot Server reports,
292–294
relationships, 98–99
TRUE function, 140–141
TRUNC function,
124–127

time series charts, 268

two pivot charts layout,
200–203

TIMEVALUE function,
113, 123

typing adjustments onworksheet, 55–57

titles (of reports), changing,
269–270
TODAY function,
113–116
Toggle Field List
icon, 12
Top 10 filter, 182–184

U
undocking field list, 28

uninstalling PowerPivot, 16
unwinding lookup tables,
91–95
updating. See also
refreshing
imported data, 78–79
linked table data, 65–67
uploading reports to
PowerPivot Server,
287–288
UPPER function, 131–133

V
VALUE function, 131, 139
values
converting pivot tables
to, 168
mapping numeric fields to,
155–157
Values area, 149, 160–161
values axis, deleting, 275
VALUES function, 239
VBA, pivot tables and, 49
vertical slicers, 203
viewing reports in
PowerPivot Server,
288–291
VLOOKUP function, 98

W

Undo feature, 44
undo/redo in data sheet
view, 109

WEEKDAY function, 113,
117–118

zoom slider adjustments
WEEKNUM function,
113, 118
width of columns
changing, 107–108
increasing, 276
worksheets, navigating, 280

wrapper functions,
COUNTROWS as, 221

X-Y-Z
XOR function, 141

YEARFRAC function, 96,
113, 119–120
YEAR function, 113, 116–
117

zoom slider adjustments,
281
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